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General Information

The OPEN SYSTEMS Accounting Software (OSAS�) product line consists of 
several accounting applications. Each application addresses a different phase
your financial operations; together, they form a powerful accounting solution to
your daily and periodic accounting needs.

The ODBC Kit

The OSAS ODBC Kit provides users with a way to access their OSAS data thro
any ODBC-compliant productivity package. The ODBC Kit includes an ODBC
driver for Windows, the data dictionaries for the OSAS data files, utilities for 
maintaining the data dictionaries and some sample reports in Microsoft� Excel, 
Microsoft Access� and Crystal Reports� for Windows.

The Report Applets

Since the release of the ODBC Kit, OSAS users have been discovering the po
of these popular productivity packages to analyze their accounting data. The 
Report Applets provide a series of pre-built Microsoft Excel PivotTables� to help 
you get the most from your accounting data. 

These tables are provided for each of the major data files in each application. 
manual includes instructions for loading and using these spreadsheets to sort
analyze your data. With a little practice, you can easily create similar PivotTab
or modify the ones provided to customize them to your exact needs.
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Direct Deposit Data Files

You use the Direct Deposit (DD) system to as an add-on to the Payroll applica
With Direct Deposit, you can calculate automatic deposits to employee accoun
create the necessary magnetic media, print vouchers for the employee and tra
amounts deposited.

DD Data Files

The Direct Deposit Report Applet contains several spreadsheets that report 
information from the OSAS Direct Deposit data files. The PivotTables in the D
Report Applet are based on these data files:

DDDIxxx

The Direct Deposit Deduction Information file stores information about each 
employee’s bank accounts and the amount of the employee’s pay to be deposi
each account. Data from this file is used in the DD Master List 
(DDMASTER.XLS) PivotTable. 

DDVKxxx

The Direct Deposit Vouchers file stores information about the direct deposits to
made during the current payroll check cycle. The information stored in this file
displayed on the DD Current Vouchers (DDCURVOU.XLS) PivotTable.

DDVHxxx

The Direct Deposit Voucher History file stores historical information about eac
direct deposit transaction from past payroll check cycles. The data stored in th
DDVHxxx file is the basis of the DD Voucher History (DDVOUHST.XLS) 
PivotTable.
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Introduction to PivotTables

A Microsoft Excel PivotTable is an interactive table that quickly summarizes, o
cross-tabulates, large amounts of data. You can rotate its rows and columns to
different summaries of the source data, filter the data by displaying different pa
or display the details for areas of interest.

A PivotTable contains fields, each of which summarizes multiple rows of 
information from the source data. By dragging a field button to another part of 
PivotTable, you can view your data in different ways. For example, you can vie
any field either down the rows or across the columns.

The PivotTable summarizes data by using a summary function, such as Sum, 
Count, or Average. You can include subtotals and grand totals automatically, o
your own formulas by adding calculated fields and items.

In the Direct Deposit Report Applet, several PivotTables are provided based on
data in the OSAS data files. The PivotTable is updated through the ODBC driv

The next section includes a tutorial for setting up and modifying PivotTables in
Excel.
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Creating Microsoft Excel PivotTables

Read this section for an exercise in creating a PivotTable using the ODBC Kit 
Microsoft Excel 97. If you require more information about Microsoft Excel, 
consult the Microsoft Excel User’s Guide or Online Help.

Before you can create this report, complete these tasks:

• Install and set up the ODBC Kit.

• Install and set up the BASIS ODBC drivers.

• Install Microsoft Excel 97 and Microsoft Query 97.

Note

This section includes instructions for using Microsoft Query with Microsoft 
Excel. If necessary, you can install Microsoft Query from the Microsoft Office 
media. You may also need to create a shortcut to Query manually.
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Building a Query For a PivotTable

1. Start Microsoft Query.

2. Under the File menu, select New.

The Choose Data Source screen appears.
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3. Select <New Data Source>, and click OK .

The Create New Data Source screen appears.

4. Enter a name you want to give the data source in field 1. You can use the 
source again.

5. Select the BASIS ODBC Driver in field 2.

6. Click Connect. 

The BASIS ODBC Driver Data Source Setup box appears.

7. Enter the file path and name of the CONFIG.TPM file you set up from wit
the OSAS ODBC software in the Database Configuration field, or select 
Browse and locate the file.
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If you have already built the shadow dictionary, click on the Advanced 
button, and check the options for No Shadow Dictionary Consistency Che
and Fast Connect to improve performance. See online help for additional
information about the options that come with the Advanced button.

8. Click OK  to connect to the data source.

You are returned to the Create New Data Source screen.

9. Select a table in field 4 if you want to select a default table source; otherw
leave field 4 blank and select any table when you develop the query. (If yo
select a table, the list of tables always starts at that table; otherwise the li
tables starts at the beginning of the list.)

The Choose Data Source box appears.

10. Select the data source you set up in the previous steps.
DD Report Applet User’s Manual1-12
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The Choose Columns screen appears.

11. Select a table you want to use in your Excel spreadsheet. For this examp
start with one table and add a second table later. Select the SOTH table, s
the columns for the spreadsheet, and click Next >.

The Filter Data box appears. 

Use the Filter Data dialog box to select specific records from the table. In
most cases, you do not need to choose anything in the Filter Data dialog 
For example, to filter out credit memos, select the field named 
TRANSACTION_TYPE, select does not equal, and then enter 4 for a value. 
(TRANSACTION_TYPE 4 is a credit memo.) 
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12. Click Next >. 

The Sort Order box appears.

Use the Sort Order dialog box to select how the data is sorted. For examp
select a field in Sort by and check Ascending or Descending. Select more
fields and orders for hierarchical sorts. For now, don’t enter any sort fields

13. Click Finish. You are returned to the Microsoft Query screen.
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The data in your query is displayed. You can delete columns by selecting
column and pressing the Delete key. You can also add a column by double-
clicking on the field name (in the SOTH file).

Note

NOTE: You can also select which fields you want in your query in step 6 abo
Instead of selecting the entire table, you can click the + box next to the table 
want and select the given fields from the list.

14. Select the following fields:

• BATCH_ID
• ORDER_NUMBER
• TRANSACTION_TYPE
• INVOICE_NUMBER
• INVOICE_DATE
• CUSTOMER_ID
• SUBTOTAL
• SALES_TAX
• TOTAL_COST

15. Select Table from the main menu, and choose Add tables.

The Add Table dialog box appears.
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16. A list of all the tables is displayed. Select the SOTD table, and click Close.

Joining Tables

17. Locate BATCH_ID in the SOTD and SOTH tables; then click and hold the
left mouse button down on BATCH_ID in the SOTH table

18. Drag the field over to the BATCH_ID field in the SOTD table and release 
mouse button. 

A line appears between the two BATCH_ID fields, joining the two fields.

19. Follow steps 17 through 18 with the ORDER_NUMBER field.

NOTE: You may get the following message. For now, click Yes to ignore the 
message and join the fields together.

20. Select the following fields from the SOTD table:

• ENTRY_NUMBER
• UNIT_COST_COMPNT
• UNIT_PRICE
• ORDERED_QTY
• SHIPPED_QTY_SELL
• BACKORDERED_QTY.

21. Select Save from the File menu to save the query.
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Using the Query in Microsoft Excel

1. Start Excel and open a new worksheet.

2. Select the Data menu; then select PivotTable Report.
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The PivotTable Wizard appears. 

3. In step 1 of the Wizard, a list of options is displayed where you can choos
your data source to be used in your PivotTable. Select External Data Source, 
and click Next >.

The PivotTable Wizard Step 2 dialog box appears. 

4. In step 2 of the Wizard, click Get Data.
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The Choose Data Source box from Microsoft Query appears. 

5. Click the Queries tab, and select the query you saved under Microsoft Que

The Choose Columns box under Query appears. 
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6. Click Next >. The query columns are displayed.

7. Click Next > to pass by Filter Data  and Sort Order options.

The Query Wizard - Finish dialog box appears.

8. Select Return Data to Microsoft Excel, and click Finish.

You are returned to the PivotTable Wizard Step 2 dialog box. 

9. Click Next >. 
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The PivotTable Wizard Step 3 dialog box appears. 

The selected fields and four areas—Page, Row, Column, and Data—to put 
fields are displayed. Drag and drop the fields to use in this report into the 
respective areas. (To display the full field name, hold the cursor on the bu
and a tool tip displays the full field name.)

10. Drag and drop the following fields:

• TRANSACTION_TYPE into Page

• INVOICE_NUMBER, INVOICE_DATE, and ENTRY_NUM into Row

• BATCH_ID into Column 

• ORDERED_QTY, SHIPPED_QTY_SELL, UNIT_COST_COMPNT 
and UNIT_PRICE into Data.
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The fields are displayed on the screen. Numeric fields dropped into the D
section become summary fields. 

11. Click Next >. 

The PivotTable Wizard Step 4 dialog box appears.

12. The last step lets you create the PivotTable either in the existing workshe
in a different worksheet. Accept the given options and click Finish.
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The PivotTable is displayed. 

Highlight rows and columns to shift them around. To display only invoices
change Transaction Type from All  to 3. Change it to 4 and credit memos are 
displayed. Totals per type are also displayed. 

Adding a Calculated Field

You can also add new fields, like profit, to the data area. To add profit to the d
area, follow these steps:

1. Highlight the last row in your data area, Sum of UNIT_PRICE, right-click, 
and select Insert.
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The Insert Calculated Field dialog box appears.

2. Enter the following information about the inserted field:

• Enter Profit Dollars in the Name field.

• Enter =(SHIPPED_QTY_SELL* UNIT_PRICE) - 
( SHIPPED_QTY_SELL* UNIT_COST_COMPNT)  in the Formula 
field.

3. Click Add.
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4. Click OK .

The PivotTable is displayed with the Sum of Profit Dollars field.
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Changing Field Properties

You can also change the properties of the fields in the table. For example, to 
remove the subtotals from the INVOICE_DATE field:

1. Place your mouse cursor on the INVOICE_DATE column heading, right-cl
and select Field... from the menu. 

The PivotTable Field dialog box appears:

You can use the PivotTable Field dialog box to change the field name, its 
orientation on the PivotTable, its display mask, subtotalling options and so

2. To shut of the subtotals, select None under Subtotals and click OK.
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The PivotTable is redisplayed reflecting your changes:
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Moving Fields and Sorting Data

You can dramatically change the appearance of the table by moving the fields
around. Fields appear on the PivotTable as gray blocks with the field name on
them. To move any field, simply drag it to a new destination.

You can change your PivotTable by moving fields in these ways:

Changing the Selection Fields

If you want to be able to limit the data in the table, you can make any field in th
table part of the selection criteria by moving it to the Page area.

For example, to select a specific batch for this table rather than displaying all t
batches across the table columns as they are in our sample table, follow these

1. Position the mouse cursor over the BATCH_ID field, press and hold the le
mouse button.

As you drag the BATCH_ID field around the table, the cursor changes to 
show where you can drop it. If the cursor looks like a block with an X over it, 
you will remove the field from the table by dropping it there.

2. Drag the BATCH_ID field to the left of the TRANSACTION_TYPE field an
drop it there.
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The change appears immediately:
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Changing the Column Data

You can change the data that appears in the columns in the table by dragging
fields or data block to the column heading area.

For example, to show the quantity, price, cost and profit information in our tab
across the columns instead of in the data block as they now appear, drag the Data 
field above the Total column heading and drop it there.

The change appears immediately:
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Changing the Data Sort

To change the order in which the data is displayed, you can simply change the
fields around. 

For example, our PivotTable is sorted by Invoice Number. To sort it by Invoice
Date instead, click and drag the INVOICE_DATE field to the left of the 
INVOICE_NUMBER field.

The data is sorted by Invoice Date and is redisplayed:

You can also drag the selection fields from the Page area to the Row area to so
data by those fields.
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More About Using PivotTables 

Feel free to experiment with the orientation of the fields on this sample report.
you become more familiar with the tables and how to use them, you can enjoy
benefits of viewing your data in new and different ways.

For more information about PivotTables, see the Microsoft Excel documentatio
online help.
DD Report Applet User’s Manual1-32
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Installation

DD Report Applet User’s Manual
You can put the Direct Deposit ODBC Report Applet on your system by install
it through Resource Manager. The installation process is described in this sec

The Direct Deposit Report Applet needs a minimum of 48 kilobytes (48KB) for
installation. You must also have installed Direct Deposit and the ODBC Kit on 
your system, and the ODBC drivers on the Windows workstation. 

Installing the Report Applet

Use the Install Application function on the Resource Manager Installation men
install the report applet. You must install the Direct Deposit application before 
install this report applet. 

The installation will treat the report applet as though you are reinstalling Direc
Deposit. This is normal behavior.

Note

You must install the applet for Payroll in order to access the employee, earnin
and other payroll information you enter.

When you install the report applet, Resource Manager copies the PivotTables t
directory where your Direct Deposit programs are stored. You must have acce
this directory from your Windows machine to access the tables in Microsoft Ex

2
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The CONFIG.TPM File

When you install the ODBC Kit, you specify the location of the data files and d
dictionaries in a file called CONFIG.TPM. You can build this file using the ODB
Kit functions. You can store this file in any directory, but the report applets exp
the file to be located in the C:\WINDOWS directory.

If your CONFIG.TPM file is stored in a different directory, you have three choic
for using the PivotTables supplied with the report applet:

1. Move the CONFIG.TPM file to the C:\WINDOWS directory and change a
Data Sources you have set up and any ODBC reports or spreadsheets yo
have already set up to use the CONFIG.TPM in its new location.

2. Copy the CONFIG.TPM file to the C:\WINDOWS directory and leave a co
in its current location. You do not need to change any Data Sources or rep
you have set up, but you need to make any changes in both files.

3. Change the PivotTables provided with this report applet to use the 
CONFIG.TPM file in its current location.  You can find instructions for doin
this below.

If you choose methods 1 or 2 above, you can load the PivotTables in Microsof
Excel and begin using them with your data by using the Refresh Data comma
Excel.

If you choose option 3, follow the instructions below to point the PivotTable to 
correct CONFIG.TPM file.
DD Report Applet User’s Manual2-2
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Using a Different CONFIG.TPM

If you store your CONFIG.TPM file in a location other than the C:\WINDOWS 
directory, you will see this message when you attempt to refresh the data in an
PivotTable included with this report applet:

When you click on OK, the BASIS ODBC Driver Data Source Setup dialog box
appears:

To specify the location of your CONFIG.TPM file, click Browse and select the f
from the location screen:
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When you select the file, the final dialog appears:

When you click on OK, the PivotTable is updated with your accounting data.  

Report Applet PivotTables

Use the descriptions of the PivotTables in chapter 3 to work with your account
data.
DD Report Applet User’s Manual2-4
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DD Current Vouchers

File Name

DDCURVOU.XLS

Description

The Direct Deposit Current Vouchers PivotTable uses the data in the Current 
Vouchers (DDVKx) file to display the vouchers prepared in the current payday
check cycle for the employees you choose.

You can use this PivotTable to review the vouchers before you print them.

Active Fields

Default Field Type Field

Page Employee ID

Row Sequence Number
Account Type 1-6

Column Current Amounts for Accounts 1-6
Net Check Amount
Direct Deposit Total
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DD Current Vouchers PivotTable Sample
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DD Master List

File Name

DDMASTER.XLS

Description

The Direct Deposit Master List PivotTable uses the data in the Deduction 
Information (DDDIx) file to display summarized account information and 
allocation amounts for each employee.

You can use this PivotTable to review each employee’s account information.

Active Fields

Default Field Type Field

Page Amount or Percent flag

Row Employee ID
Account Number 1-6

Column Allocation Amount or Percent 1-6
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DD Master List Direct Deposit PivotTables
DD Master List PivotTable Sample
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DD Voucher History

File Name

DDVOUHST.XLS

Description

The DD Voucher History PivotTable uses the data in the Voucher History 
(DDVHx) file to display details about vouchers you’ve printed in past payroll 
check runs. 

The information is sorted by History Sequence Number, but you can easily cha
the sort or include Employee ID in the sort.

You can use this PivotTable to review and analyze your historical direct depos
transactions.

Active Fields

Default Field Type Field

Page Employee ID

Row Sequence Number
Account Type 1-6

Column Account 1-6 Amounts
Net Check Amount
Total Direct Deposit Amount
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DD Voucher History PivotTable Sample
DD Report Applet User’s Manual3-8



Index

DD Report Applet
User’s ManualIX
Index
A
accessing data

Microsoft Excel� ���

D
data files

in DD� ���

Data Source
creating a new source� ����
Fast Connect� ����
No Shadow Dictionary Consistency Check� ����

selecting a data source� ����

DD Current Vouchers PivotTable
description� ���
files used in� ���
sample report� ���
screen� ���

DD Master List PivotTable
description� ���
files used in� ���
sample report� ���
screen� ���

DD Voucher History PivotTable
description� ��	
files used in� ���
sample report� ��

screen� ��


DDCURVOU.XLS
data files� ���
description� ���

DDDIxxx
file description� ���

DDMASTER.XLS
data files� ���
description� ���

DDVHxxx
file description� ���

DDVKxxx
file description� ���

DDVOUHST.XLS
data files� ���
description� ��	

Direct Deposit
data files� ���
description� ���
installing� ���
system requirements� ���

F
Fast Connect

Microsoft Query� ����

I
installing the applet� ���

M
Microsoft Excel� ���

PivotTable layout� ����
PivotTable sample� ����
PivotTable wizard� ���	
selecting a data source� ���


Microsoft Query� ���
adding tables� ����
building a query� ����
Filtering data� ����
joining tables� ����
Selecting a table� ����
Sorting data� ����
DD Report Applet User’s Manual IX-1



Index
N
No Shadow Dictionary Consistency Check

Microsoft Query� ����

O
ODBC Kit

definition� ���
OSAS

general information� ���

P
Payroll

installing the applet with� ���
PivotTable

adding a calculated field� ����
changing column data� ����
changing data sort� ����
changing field properties� ����
changing selection fields� ���

definition� ��	
moving fields� ���


PivotTable Wizard
Choosing a data source� ���


getting the data� ���

laying out the table� ����
returning the data� ����

PivotTables
DD Current Vouchers� ���
DD Master List� ���
DD Voucher History� ��	

R
Report Applet

requirements for� ���
report applet

installation� ���
definition� ���

S
spreadsheets

DD Current Vouchers� ���
DD Master List� ���
DD Voucher History� ��	

system requirements� ���
IX-2
 DD Report Applet User’s Manual


	Direct Deposit ODBC Report Applet User’s Manual
	Introduction
	General Information
	The ODBC Kit
	The Report Applets

	Direct Deposit Data Files
	DD Data Files
	DDDIxxx
	DDVKxxx
	DDVHxxx


	Introduction to PivotTables
	Creating Microsoft Excel PivotTables
	Building a Query For a PivotTable
	Joining Tables

	Using the Query in Microsoft Excel
	Adding a Calculated Field
	Changing Field Properties
	Moving Fields and Sorting Data
	Changing the Selection Fields
	Changing the Column Data
	Changing the Data Sort

	More About Using PivotTables



	Installation
	Installing the Report Applet
	The CONFIG.TPM File
	Using a Different CONFIG.TPM
	Report Applet PivotTables

	Direct Deposit PivotTables
	DD Current Vouchers
	File Name
	Description
	Active Fields
	DD Current Vouchers PivotTable Sample

	DD Master List
	File Name
	Description
	Active Fields
	DD Master List PivotTable Sample

	DD Voucher History
	File Name
	Description
	Active Fields
	DD Voucher History PivotTable Sample


	Index


